BAB Il

ANALISIS DAN DESAIN SISTEM

I11.1. Analisis Masalah

Analisa sistem pada yang berjalan bertujuan untuk mengidentifikasi serta
melakukan evaluasi terhadap Sistem Pencarian Jalur Terpendek Penjualan Sepeda
Motor Bekas Dengan Menggunakan metode greedy best first search, analisis
dilakukan agar dapat menemukan masalah-masalah yang sedang berjalan pada
perusahaan dengan metode greedy best firstsearchdalam menentukan nilai dari
setiap data produk. Adapun permasalahan pada sistem yang sedang berjalan
adalah :

1. Rute terpendek lokasi penjualan sepeda motor bekas sulit ditemukan.

2. Belum adanya sistem yang dapat mencari jalur terpendek penjualan sepeda
motor bekas.

3. Diperlukannya sebuah metode untuk menemukan jalur terpendek penjualan
sepeda motor bekas.

Berdasarkan analisa diatas maka penulis telah melakukan evaluasi dari
sistem yang sedang berjalan dan penulis menemukan kelemahan sistem yang ada.
Adapun kelemahan tersebut seperti: belum ada sistem untuk pencarian jalur
terpendek penjualan sepeda motor bekas sehingga memakan banyak waktu untuk
mencari lokasi penjualan sepeda motor bekas. Demikian juga dengan informasi
atau data mengenai penjualan sepeda motor bekas yang sulit didapat karena harus

mengecek satu persatu.
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Dengan melihat uraian diatas penulis memberikan suatu solusi atau
strategi pemecahan masalah yang diharapkan dapat mengatasi kelemahan sistem
yang ada. Adapun solusi yang ditawarkan adalah aplikasi Pencarian Jalur
Terpendek Penjualan Sepeda Motor Bekas Dengan Menggunakan metode greedy
best first search dengan menggunakan bahasa pemrograman php dan database
mysql. Sistem Pencarian Jalur Terpendek Penjualan Sepeda Motor Bekas Dengan
Menggunakan metode greedy best first search ini adalah salah satu alat yang

diyakini mampu memberikan konstribusi positif bagi perusahaan.

111.1.1 Evaluasi

Berdasarkan analisa diatas maka penulis telah melakukan evaluasi dari
sistem yang sedang berjalan dan penulis menemukan kelemahan sistem yang ada.
Adapun kelemahan tersebut seperti: belum ada sistem untuk pencarian jalur
terpendek penjualan sepeda motor bekas sehingga memakan banyak waktu untuk
mencari lokasi penjualan sepeda motor bekas. Demikian juga dengan informasi
atau datamengenai penjualan sepeda motor bekas yang sulit didapat karena harus
mengecek satu persatu.
111.1.2 Strategi Pemecahan Masalah

Dengan melihat uraian diatas penulis memberikan suatu solusi atau
strategi pemecahan masalah yang diharapkan dapat mengatasi kelemahan sistem
yang ada. Adapun solusi yang ditawarkan adalah aplikasi Pencarian Jalur
Terpendek Penjualan Sepeda Motor Bekas Dengan Menggunakan metode greedy

best first searchdengan menggunakan bahasa pemrograman php dan database
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mysql. Sistem Pencarian Jalur Terpendek Penjualan Sepeda Motor Bekas Dengan
Menggunakan metode greedy best first searchini adalah salah satu alat yang

diyakini mampu memberikan konstribusi positif bagi perusahaan.

111.2. Penerapan MetodeGreedy Best First Search

Algoritma greedy merupakan algoritma yang paling popular untuk
memecahkan masalah optimasi. Algoritma ini membentuk solusi langkah per
langkah. Pada setiap langkah, banyak pilihan yang perlu dieksplorasi. Oleh karena
itu, pada setiap langkah harus dibuat keputusan terbaik dalam menentukan pilihan.

Algoritma greedy best first search adalah salah satu cabang dari algoritma
best first search. Algoritma best first search merupakan metode untuk
membangkitkan simpul dari simpul sebelumnya (yang saat ini adalah simpul
terbaik menurutnya). Dalam Greedy Search, keputusan diambil menggunakan
fungsi evaluasi f(n) tetapi tanpa mempertimbangkan nilai sebenarnya g(n) karena
informasi nilai g(n) tidak berguna sebab Greedy Search tidak peduli dengan nilai
sebenarnya. Greedy Search hanya akan mempertimbangkan nilai heuristik h(n)
yang ditetapkan dengan aturan tertentu sedemikian rupa sehingga simpul yang

dipilih adalah simpul terbaik.

Langkah-langkah dalam algoritma Greedy Search adalah sebagai berikut:
1. Masukkan simpul awal ke Open List.
2. Tentukan metode untuk menentukan nilai heuristik h(n).

3. Bangkitkan simpul dan hitung nilai heuristik h(n) untuk setiap simpul.
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4. Pilih simpul dengan h(n) paling optimal.

5. Perbarui nilai setiap simpul yang berubah karena keadaan tertentu
(misalnya karena digabung dengan simpul lain).

6. Jika telah mencapai solusi, berhenti. Jika belum, ulangi langkah 2 sampai
ditemukan solusi. (Ikhwanul Muslimin,2016)

Berikut flowchart algoritma Greedy Best First Search:

Mulai Ambil masukkan jarak
kedalam table jarak, sebagai

titik terdekat <

v

A

Inisialisasi Titik Awal Dan l
Jarak Titik Tetangga

Titik Terdekat Sudah Ada

Dalam Array Rute?

v

Beri Label Sementara
Untuk Jarak Antar Titik
Tetangga Maks 50 Km

Masukkan Titik Terdekat

Sebagai array Rute

Tentukan Jarak l
Minimum Dari

Tiap Titik Tetangga .

Gambar I11.1. Flowchart Algoritma Greedy Best First Search

Contoh Kasus :

Misalnya kita akan menggunakan algoritma Greedy Best First Search untuk
mencari Jalur terpendek dari pejual sepeda motor.

1. Mulai dari keadaan awal, tentukan titik koordinat awal longitude = 98.666389 ,

latitude = 3.6376651 , simpan sebagai posisi awal saat ini
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2. Lakukan perulangan hingga tujuan tercapai atau hingga pencarian tidak
memberikan perubahan pada keadaan sekarang.
3. Tentukan simpul sebagai nilai heuristik dari node-node.
Untuk kondisi saat ini maka simpul dari tetangga terdekat adalah
NodeTitik B, Longitude = 98.67832Latitude=3.65479
Node Titik D, Longitude = 98.6784 Latitude=3.617
Node Titik E, Longitude = 98.6859 Latitude=3.6225
Tentukan simpul dan hitung jarak tempuh masing-masing node simpan dalam

variabel jarak tempuh.

[Posisi Awal] , Titik B, Titik D, Titik E
(Jarak Tempuh = 16.96 km)

4. Lakukan untuk tiap node yang digunakan oleh keadaan sekarang.

a. Gunakan node tersebut dan bentuk keadaan baru.

b. Evaluasi keadaan baru tersebut jika merupakan tujuan keluar. Jika bukan,
bandingkan nilai keuristiknya dengan simpul. Jika lebih baik, jadikan nilai
heuristik keadaan batu tersebut sebagai simpul baru, tetapi jika tidak lebih
baik, nilai simpul tidak berubah.

Jika simpul lebih baik daripada nilai heuristik keadaan sekarang, ubah

node simpul menjadi keadaan sekarang.



simpul[1]

[Posisi Awal] , Titik B , Titik D, Titik E
[7.55km]

(Maval, Tarmnith — 12 O2 L)
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[Posisi A?\da] , [Posisi Awal] , [Posisi Anda] , [Posisi Anda] , [Posisi Anda] ,
Titik B, Titik Titik D, Titik Titik D, Titik Titik E , Titik Titik E , Titik
E, Titik D B, Titik E E, Titik B B, Titik D D, Titik B
(Jarak Tempuh (Jarak Tempuh (Jarak Tempuh (Jarak Tempuh (Jarak Tempuh
=7.04 km) =10.55 km) =7.38km) =10.63 km) =7.98 km)
simpul[2] simpul[3] simpul[4] simpul[5] simpul[6]
Gambar 111.2. Detail Algoritma Greedy Best First Search

Simpul[1] = [posisi anda—B] + [B—D] + [D—E] + [E—E]
=2.31924801169216 + 4.20206565580093 + 1.03283142302399
+0
= 7.554145091 dibulatkan 7.55
Simpul[2] =[posisi anda—B] + [B—E] + [E—D] + [D—D]
= 2.31924801169216 + 3.68769903996286 + 1.03283142302399
+0
=7.039778475 dibulatkan 7.04
Simpul[3] = [posisi anda—D] + [D—B] + [B—E] + [E—E]

= 2.65644897693802 + 4.20206565580093 + 3.68769903996286

+0

=10.54621367 dibulatkan 10.55



44

Simpul[4] =[posisi anda—D] + [D—E] + [E—>B] + [B—B]
= 2.65644897693802 + 1.03283142302399 + 3.68769903996286
+0
= 7.37697944 dibulatkan 7.38
Simpul[5] =[posisi anda—B] + [B—D] + [D—E] + [B—B]
= 2.74436048350447 + 1.03283142302399 + 4.20206565580093
+0
= 7.979257562 dibulatkan 7.98
Simpul[6] =[posisi anda-B] + [B—D] + [D—E] + [D—D]
= 2.74436048350447 + 3.68769903996286 + 4.20206565580093
+0
=10.63412518 dibulatkan 10.63
Dari evaluasi setiap node simpul diatas, simpul[1] memiliki jarak tempuh
sepanjang 7.55 km, simpul[2] memiliki jarak tempuh sepanjang 7.04 km,
simpul[3] memiliki jarak tempuh sepanjang 10.55 km, simpul[4] memiliki jarak
tempuh sepanjang 7.38km, simpul[5] memiliki jarak tempuh sepanjang 7.98 km,
simpul[6] memiliki jarak tempuh sepanjang 10.63 km, maka dapat diambil

kesimpulan rute terpendek dari node simpul-simpul adalah simpul[2].

111.3 Desain Sistem
111.3.1 UseCase Diagram
Model use case adalah dialog antara aktor dengan sistem. Usecase

mempresentasikan fungsionalitas yang disediakan oleh sistem yang tampak oleh
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aktor. Sebuah use case adalah suatu fungsionalitas tingkat tinggi yang disediakan
sistem. Dengan kata lain use case menggambarkan bagaimana aktor
menggunakan sistem, untuk lebih jelasnya perhatikan use case diagram aplikasi

penjualan sepeda motor yang dibuat:

Sistem Informasi Geografis Pencarian Jalur Terpendek Penjualan
Sepeda Motor Bekas Dengan Menggunakan Metode Greedy Best

First Search

Melihat Tentang
Program

dashboard
. Pencarian jalur
<extends> terpendek
Kecamatan - /
<extends>

TT<extends> ____\ Melihat tokot user

Admin

Motor bekas

Gambar 111.3. UseCase Diagram Aplikasi Pencarian Jalur Terpendek
Penjualan Sepeda Motor Bekas
111.3.1.Class Diagram
Class diagram digunakan untuk menampilkan kelas-kelas dan paket-paket
di dalam system. Class diagram memberikan gambaran system secara statis dan
relasi antar mereka. Biasanya, dibua beberapa class diagram untuk sistem tunggal.

Beberapa diagram akan menampilkan subset dari kelas-kelas dan relasinya. Dapat
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dibuat beberapa diagram sesuai dengan yang diinginkan untuk mendapatkan

gambaran lengkap terhadap sistem yang dibangun.

Class Diagram
kecamatan oeta
-ldkecamatan —
-nama_namakecamatan 1. -ldtoko
-idkecamatan
:‘t;r;(b)ah() 1 -id spmotor
+hapus() +cari() ;
1.* 1
toko 0.%
-id_toko
-id_kecamatan motor
-nama_toko
-long -id_spmotor
-lat -id_toko
1. -alamat -nama_spmotor
-photo -harga
-telp -photo
+Update() -deskripsi
+Tambah()
+Edit()
+Hapus()

Gambar 111.4. Class Diagram Aplikasi Pencarian Jalur Terpendek Penjualan
Sepeda Motor Bekas

111.3.2.Activity Diagram

Activity diagram  memiliki  pengertian yaitu lebih fokus kepada
menggambarkan proses bisnis dan urutan aktivitas dalam sebuah proses. Dipakai
pada business modeling untuk memperlihatkan urutan aktifitas proses bisnis.
Memiliki struktur diagram yang mirip flowchart atau data flow diagram pada

perancangan terstruktur.
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1. Activity Diagram Login
Activity diagram login menggambarkan logika login bagi admin ketika ingin

masuk kedalam halaman administrator, berikut desain activity diagram login

kagin

Admin Sistem

Buka Aplikasi \\ Login

Isi Username

i s

Gagal

Isi Password

o
JRY

Click Login

Berhasil

Phase

Gambar I11.5.Activity Diagram Login Sistem

2. Activity Diagram Data Toko

Activity diagram data tokomenggambarkan prosedur penyimpanan, merubah

data, menghapus data serta menampilkan informasi data toko, berikut adalah

activity diagram yang penulis rancang.
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Admin sistem

Qtart

Klik Input k/Form Input

Data toko '\ Data toko
{Klik New \4
l /

a

Isi Data
TAdle valjd
tidale

( Klik Simpan
valid
r
TAle valid

tidale
valid
Klik Hapus ;(Data Terupdate )
ya > Data Terhapus

tidale

»( Data Tersimpan
N

End

Gambar I11.6.Activity Diagram Data Toko
3. Activity Diagram Data Sepeda Motor
ctivity diagram data sepeda motormenggambarkan prosedur penyimpanan,
merubah data, menghapus data serta menampilkan informasi data sepeda motor,

berikut adalah activity diagram yang penulis rancang.
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Admin

sistem

Qtart

®

;/ Form Input

Klik Input
Data somotor

'\ Data spmotor

)

{Klik New \4
l J

tidal

( Klik Simpan

TAle valid

- lid
Pilih Data b

( Klik Edit )
Ubah Data
Klik Update Tdle valid

valid

e -
»( Data Tersimpan
N

D

tidale
Klik Hapus

ya

>K Data Terupdate
\

)

tidale

End

> Data Terhapus

Gambar I11.7.Activity Diagram Sepeda Motor

4. Activity Diagram Pencarian Toko

Pada activity diagram Pencarian Toko menggambarkan tentang pencarian

penjualan toko Sepeda Motor

Bekas terdekat.

Diagrampencarian Toko terdekat dapat dilihat pada gambar.

Adapun

Activity
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User sistem

Start

?
< Pilih Home >

y

A
< Memilih Maps >
A 4
(Menampilkan Maps>

A 4

Input alamat untuk ] ( -
Menampilkan Data Pilih Jarak terdekat>

A 4

Memproses Tampilan
Data

\ 4

Menampilkan Data
toko terdekat

1
@

End

Gambar 111.8. Activity Diagram Pencarian Toko
5. Activity Diagram Tentang Program
Pada activity diagramTentang Programmenjelaskan bahwa informasi atau
data diri pembuat program. Adapun Activity Diagram Tentang Program dapat

dilihat pada gambar 111.9.
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User sistem

Masuk Menu Utama
Pilih Tentang Program }—

Lihat Informasi
Tentang Program

Gambar 111.9. Activity Diagram Melihat Tentang Program
111.2.4. Sequence Diagram
Sequence diagram adalah suatu penyajian perilaku yang tersusun sebagai
rangkaian langkah-langkah percontohan dari waktu ke waktu. Sequence diagram
digunakan untuk menggambarkan arus pekerjaan, pesan yang sampaikan dan
bagaimana elemen-elemen di dalamnya bekerja sama dari waktu ke waktu untuk

mencapai suatu hasil.

111.2.4.1 Sequence DiagramLogin Admin
Sequence diagram login admin menggambarkan prosedur kerja login oleh

admin, berikut adalah sequence diagram yang dirancang



login Proses login

halaman menu utama

admin

| input username

| dan password

|
|
|
|
|
|
cek validasi :

»

v

koneksi

database
'|_r invalid
o -

login sukses

|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
1

Gambar 111.10Sequence DiagramLogin

111.2.4.2 Sequence Diagram Data TokoSepeda motor
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Sequence diagram data toko sepeda motor menggambarkan prosedur kerja

dari penambahan data tokosepeda motor oleh admin, berikut adalah sequence

diagram data tokosepeda motor yang dirancang.
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Admin Main form Form toko Tabel toko

1
Tampilkan Fom ()

N
|

_|_
Menu ()
I click form
toko () -

T update data ()

T
I
|
I
|
I
|
! » Close form () |
7 7 |

Gambar I11.11Sequence Diagram Data Tempat Sepeda motor

111.2.4.3Sequence Diagram Data Sepeda motor
Sequence diagram data sepeda motormenggambarkan prosedur kerja dari
penambahan datasepeda motor oleh admin, berikut adalah sequence diagram data

sepeda motoryang dirancang.

Admin Main form Form motor Tabel motor

Tampilkan Fom (LD
click form

I

I

I

I
I:I, motor () ‘D

I

I

Menu ()

I
I
I
I
I
| | update data () ‘J;

I_lej

delete data ()

I
I
I
I
I
| L Close form () | |
L L] |

Gambar 111.12. Sequence Diagram DataSepeda motor




111.2.4.4 Sequence DiagramPeta
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Sequence diagram peta online kota medan menggambarkan prosedur kerja

untuk menampilkan peta online kota medan, berikut adalah sequence diagram

peta online yang dirancang.

Menu Utama

Peta

Informasi toko

— ——

Buka Program Pilih Peta

Klik alamat

»

v

Y

Kembali lihat Peta

Kembali Menu Utarna

&
<«

A

Gambar 111.13. Sequence Diagram Peta

111.3 Disain Database

Perancangan database merupakan kumpulan dari tabel-tabel yang

digunakan untuk menyimpan informasi penjualan sepeda motor dan tempat

penjualan sepeda motor, table yang ada pada database sebanyak 2 buah table dan

digunakan untuk menyimpan informasi, berikut adalah desain table yang

digunakan dan kamus data yang dibuat

111.3.1 Kamus Data

Kamus data merupakan suatu daftar terintegrasi tentang komposisi elemen

data, aliran data dan data store yang digunakan. Pengisian data dictionary
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dilakukan setiap saat selama proses pengembangan berlangsung, ketika diketahui
adanya data atau saat diperlukan penambahan data item kedalam sistem. Berikut
kamus data dari aplikasi yang dibuat:

Database : dbputri, Nama Tabel : user; Primerykey : id

Tabel 111.1. Tabel Admin

No Field Name Type Width Keterangan

1 Id Int 11 ID Admin

2 | username Varchar 50 Nama Admin

3 | password Text 0 Kata Sandi Admin
User = ({id} + username + password )
Spmotor = ({id_spmotor} + id_toko + nama_spmotor+ harga+ photo)
Kecamatan = ({id_kecamatan} + nama_kecamatan)
Toko =({id_toko}+id_kecamatan+ nama_toko+long+ lat+  alamat+

photo + telp)

111.3.2 Disain Tabel / File
Database : dbputri, Nama Tabel : user; Primerykey : id

Tabel 111.2. Tabel Admin

No Field Name Type Width Keterangan
1 Id Int 11 ID Admin
2 username Varchar 50 Nama Admin

3 | password Text 0 Kata Sandi Admin
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Database : dbputri, Nama Tabel : kecamatan; Primerykey : id_kecamatan

Tabel 111.3 Tabel Kecamatan

No Field Name Type Width Keterangan
1 Id_kecamatan Varchar |7 ID kecmatan
2 Nama_kecamatan | Varchar | 50 Nama kecamatan

Database : dbputri, Nama Tabel : toko; Primerykey : id_toko

Tabel 111.4 Tabel Toko

No Field Name Type Width Keterangan
1 id_toko Int 5 ID toko
2 id_kecamatan Varchar 7 Id kecamatan
3 nama_toko Varchar 255 Nama toko
4 Long Double 0 Longitude
5 Lat Double 0 Latitude
6 Alamat Varchar 255 Alamat toko
7 Photo Varchar 255 Photo
8 Telp Varchar 20 Telp toko

Database : dbputri, Nama Tabel : spmotor; Primerykey : id_spmotor

Tabel 111.5 Tabel Motor

No Field Name Type Width Keterangan
1 id_spmotor Int 5 ID spmotor

2 id_toko Int 5 Id toko

3 nama_spmotor | Varchar | 255 Nama spmotor

4 harga Varchar | 255 Harga Spmotor

5 photo Varchar | 255 Photo

6 deskripsi Varchar | 500 Deskripsi

I11.4 Perancangan Antar Muka
Dalam hal ini penulis akan membahas perancangan sistem yang akan
dibangun secara terperinci, perancangan yang dibuat terdiri dari perancangan

system dan perancangan database.
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111.4.1 Desain Form Utama

Desain form utama merupakan desain muncul ketika aplikasi dijalankan oleh

user, berikut adalah desain dari form utama yang dirancang.

Logo
Menu
Home Selamat Datang
Tentang Calawmant Aatanma M
Kabar Berita Selamat datang Di Aplikasi Pencarian Sepeda Motor, Silahkan
kelik Menu Di Sebelah Kiri Untuk Mengakses Content Yang Ada
Pencarian Pada Website Ini
Toko SP Motor
footer

Gambar 111.14. Desain Form Utama
111.4.2 Desain FormTentang Program
Desain formTentang Program merupakan rancangan desain Yyang
digunakan untuk tentang program, berikut adalah rancangan desain yang penulis

buat.
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Logo
Menu
Home Tentang program ini
Tentang
: Programini Dibuat Untuk Kelengkapan Skripsi
Kabar Berita Nama :
Nim :
Pencarian terdekat Program Studi
Peminatan
Toko SP Motor

footer

Gambar 111.15. Desain FormTentang Program

111.4.3 Desain Form Kabar Berita
Desain formkabar berita merupakan rancangan desain yang digunakan
untuk kabar berita seputarsepeda motor, berikut adalah rancangan desain yang

penulis buat.

Logo

Menu

Home Kabar Berita

Tentang

Isi berita terkini seputar sepeda motor bekas

Kabar Berita

Pencarian terdekat

Toko SP Motor

footer

Gambar 111.16. Desain Form Kabar Berita
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111.4.4 Desain Form Pencarian Toko Terdekat
Desain form Pencarian toko terdekat merupakan rancangan desain yang
digunakan untuk menampilkan dan mencari data tempat sepeda motor, berikut

adalah rancangan desain yang penulis buat.

Logo

NMann

Home Pencarian toko terdekat

Tentana
Kabar Berita Peta

Pencarian terdekat

Tokn SP Maotar

footer

Gambar 111.17. Desain Form Pencarian Toko Terdekat

111.4.5 Desain Form Data Toko
Desain form data toko merupakan rancangan desain yang digunakan untuk

menampilkan dan mencari data Toko, berikut adalah rancangan desain yang

penulis buat.
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Logo

Menti

Home

Tentang

Kabar Berita

Pencarian terdekat

Tokn SP Motor

Data toko | [ o |

no  Nama Long Lat Kecamatan ~ Alamat photo

Toko
1 XXX XXXX XXX XXX XXX XXX
2 XXX XXXX XXX XXXX XXXX XXX
footer

Gambar 111.18. Desain Form Data Toko

111.4.7. Desain Output dapat diakses oleh admin

Halama form login admin adalah halaman untuk seorang admin, yang

berhak mengedit, menambah maupun menghapus data pada Sistem Informasi

Geografis lokasi penjualan Sepeda motor, berikut ini gambar 111.19 menunjukkan

halaman informasi.

BANNER
Login Admin
User
Password
| |
| |
Logi

Gambar 111.19. Perancangan Halaman Login
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111.4.8. Disain menu Utama pada Administrator
Berikut ini gambar 111.20 menunjukkan halamanform utama untuk admin

pada sistem informasi geografis lokasi penjualan sepeda motor.

Header

Menu Selamat Datang Di Jendela administrator
Dashboard

> Master File
> Kecamatan
> Toko

> Spmotor

Footer

Gambar 111.20. Disain menu Utama Administrator
111.4.9. Disain input data kecamatan pada Administrator
Berikut ini gambar 111.21 menunjukkan halamanform untuk input

datakecamatan pada sistem informasi geografis lokasi penjualan sepeda motor.

Header
Menu Master Kecamatan
Dashboard Tambah Kecamatan
> Master File No Kode Nama Kecamatan AKksi
> Kecamatan XX XXXXXX X(50) Edit  Hapus

XX XXXXXX X(50) Edit  Hapus

> Toko XX XXXXXX X(50) Edit  Hapus
> Spmotor

Footer

Gambar 111.21. Disain input data kecamatan
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111.4.10. Disain input data toko pada Administrator
Berikut ini gambar 111.22 menunjukkan halamanform untuk input data toko

pada sistem informasi geografis lokasi penjualan sepeda motor.

Header

Menu Master Toko

Dashboard Tambah Toko

> Master no Nama Long Lat Kecamatan Alamat photo Telp ¢
File Toko

>

Kecamatan XX X(255) xxxx  xxx  Xx(50) X(255) image x(20) Edit
> Toko XX X(255) xxx XxXxx  X(50) X(255) Image x(20) Edit
>Spmotor XX X(255)  xxx Xxx  Xx(50) x(255) image x(20) Edit
Footer

Gambar 111.22. Disain input data toko
111.4.11. Disain input data sepeda motor pada Administrator
Berikut ini gambar 111.23 menunjukkan halamanform untuk input data sepeda

motor pada sistem informasi geografis lokasi penjualan sepeda motor.
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Header

Menu Master Spmotor

Dashboard Tambah Spmotor

> Master no Nama Nama Harga photo Telp aksi
File Spmotor Toko

>

Kecamatan XX X(255) X(255) XXXXXXXX image X(20) Edit Hapus
> Toko XX X(255) X(255) XXXXXxxX Image x(20) Edit Hapus
>Spmotor XX X(255) X(255) XXXXXXXX image x(20) Edit Hapus
Footer

Gambar 111.23. Disain input data sepeda motor




